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Bulk Updates

Bulk update is an efficient way of updating multiple objects in a single operation, and it is available on the majority
of objects in Tree or System Setup that have an editor.

A user can run the bulk update process on a collection, a search result, or objects in tree or system setup. Itis also
possible to select multiple objects and run a bulk update on all selected objects. See the Running Bulk Updates

topic within the Bulk Updates documentation for more information.
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Running Bulk Updates

The bulk update functionality allows a user to easily update large amounts of objects in a single operation.
There are three possible ways to run a Bulk Update:

1. ltcan be run on all objects in a single collection or multiple collections. To do so, right-click the relevant
collection(s) in Tree and choose Run Bulk Update.

- i Entity Root
ﬁ Publications
1‘_=| Frimary Product Hierarchy

=3 Collections
[ [0 Assets made with Search
=0 Copy i o
1. 13 & RunBulk Update
wl 18 ik Export Data Below
ol 18 Republish...
A 27 Refresh
& [J Digital : -
B [ Flashi Edit Search Criteria...
- (5 Party # Delete
- |5 PetHz

Search Below

2. ltcan be run on a single or multiple selected objects in Tree or System Setup. To do so go to File > Bulk Update
> Run Bulk Update.
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File Edit View Mavigate Format Maintain Window Help
Translate > (¥ URL |ntextid=Ce
Import >
Export > WEER) | References || Refer
P Reports :
Bulk Update : %] Run Bulk Update
Schedule Category Profiling Schedule Bulk Update
B save Ctrl+Alt+5

Change Password

Empty Recycle Bin

&&=

Ermnpty Recycle Bin Before...

Purge old revisions

Check integrity of external assets...
Migrate assets/DTP documents to file system...

Pre-generate Thumbnail Cache...

Close Window

Exit STEPworkbench

|:r|_| Dallelries

|- Batteries Items

- | 20881 C Battery 2P
-|{™ 20881 AA Battery 2
- |{® 20888 AAA Batteries
i--Jjjjj Batteries Deco Ttems
‘ Batteries Recharge Ttem

E

STEP Worlflow

Objects that it can be run on in Tree are:
o Assets
« Classifications
« Collections
« Configurations
« eCatalogues
« Entities
« IndexWords
« Products

« Publications
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Objects that it can be run on in System Setup are:

Attributes

Attribute Transformations

Asset Importer

Change Packages

Completeness Metrics

Event Processors

Event Queues

Gateway Endpoints

GDSN- Data pool- Receiver or publisher
Global Business Rules (actions, conditions, and libraries)
Inbound Integration Endpoints

Keys

List of Values

Match Codes and Matching Algorithms
Outbound Integration Endpoints
Tables

Tags

Units

Users and Groups

Web Uls

Workflows

Workflow Profiles

Reference types/ link types

Object type & structures (asset, classification, publication, setup group, etc.)

Context -Dimension points

, at the bottom of the Search pane.
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Lastly, it can be run on search results. To do so, perform a search and then click on the Bulk Update button,



Search Below ™
’VBatteries Itemns (20873) ﬂ
g Reset |
Displaying 4 of 4 results Show Details
Mame >

I 20881 AA Battery 2 Pk ID = 20851
W 20881 C Battery 2 Pack I = 109004
I 20888 AAA Batteries 1D = 109005

i Batteries Items [ = 20875
-Operations on Entire Result

0 @ [

StiboSystems

For more on how to perform searches using the Search tab in STEP Workbench, see the Search Overview topic

in the Getting Started / User Guide documentation.

After selecting one of the three options above to run a bulk update, the Bulk Update wizard will appear. Steps for
navigating through the Bulk Update wizard are described in the Bulk Update Wizard in the Bulk Updates

documentation.
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Bulk Update Wizard

The Bulk Update wizard guides a user through the bulk update process, and ensures all necessary settings and
datais provided to run the bulk update.

Step 1 - Configuration
In step 1, specify whether an existing configuration should be run for the bulk update, or if a new configuration
should be created.

If a user has a saved bulk update configuration they can click the ellipsis button (...) to select the relevant
configuration. Otherwise, select Create New Configuration, and click Next.

$2 Bulk Update

Steps Configuration
1. Configuration
2, Operations
3. Parameters
4. Preview O |se Existing Configuration
5. Advanced (®) Create New Configuration

Finish Cancel

Back

Step 2 - Operations

In step 2, specify the operations needed for the bulk update to perform. If an existing configuration was selected,
all operations are listed in the order they are carried out.

If an operation is not already present, select from the dropdown menu the operations that should be applied to the
set of objects.
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$2 Bulk Update

Steps Operations
L. Configuration || Merge Aribute Vahes = :
2. Operati Merge Attribute Values . into . E
3. Parameters
: Attribute values >
4. Preview
i *
5 Advanced Data Containers | Zlues »
Data Cuality H
Publishing b
References and Links >
Workflow ¥
Fun Business Rule
Send Republish Event
Set Mame
Set Object Type

Add Operation

Back Mext Finish Cancel

The selected operation dictates what elements need to be filled out. The required elements vary from operation to
operation. For a detailed description of the operations, see the Bulk Update Operations topic within the Bulk
Update documentation.

More than one operation can be applied to a bulk update by selecting 'Add Operation'. To change the order of the
operations applied to the update, use the up and down arrows []. An operation can be deleted by clicking the [><].

32 Bulk Update

Steps Operations
S ETIET References and Links|Add Reference Type: = Supplier Link, Target = Products EEERES
2. Operations
Claim -
3. Parameters v
J i | Workflow3

4. Preview STEP Workflow -
5. Advanced Current State: | 2nd State b

|

IAdd Operation I

Back Mext Finish Cancel
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Important: Ensure that the operations are listed in the order that they are needed to perform. Operations are
performed from the top down. This means that operations further down the list overwrite operations further up.
This includes when more than one operation is specified. The operations still are applied in the listed order. If one
operation fails for an object (ex: due to validation base type mismatch), all changes to the object will be rolled back
and the object will be left as if was prior to applying the Bulk Update.

Step 3 - Preview

This screen shows examples of the results of the update. It displays a maximum of 10 objects. For each object the
existing data and how the data will look after the update is applied displays.

$2 Bulk Update

Steps Preview
1. Configuration Object > > |add Reference >|
2. Operations . ol 0 reference(s) of type
3. Parameters | H8214-012 iupﬂerhnk{ ot
4. Previ X New re .rer!ce 5) of type
SupplierLink
5. Advanced . ol 0 reference(s) of type
SupplierLink
—18215-012
s New 1 reference(s) of type
SupplierLink
0 reference(s) of type
’ Old SupplierLink
_18217-012 —
X 1 reference(s) of type
Mew .
SupplierLink
X ol ] reﬁlerencle{s} of type W
Back Finish Cancel

The preview also displays warnings and errors if an operation that a user has chosen is not applicable. If a user
hovers the cursor over the icons, they can see the error or warning text.

e

Ik&

tk - Error messages:

k ﬂ Wammg.m gest Unable to create reference of type Websitelink from Product 20862 to Classification Caps
= Mot applicable — - - -

Click the Back button to change an operation or parameter. When satisfied with the preview, click Next to
continue.

Step 4 - Advanced

In the final step, select one or more options, some of which can be selected simultaneously.
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32 Bulk Update

Steps Advanced
1. Configuration
2. Operations |:| D'I'”'Z't“-"""":""‘*‘
3¢ Parametens I:l Auto Approve
4, Preview
5. Advanced [] Pre-flight

[ ] 5ave Configuration |

Process Description: Bulk Update
Avalilable for object types | All e
Back Mext Finish Cancel

« Selecting Do not run now allows the user to run the bulk update later, and not immediately when the wizard is
finished. When selecting this option, a user can still save the configuration, but Auto Approve and Pre-flight
are disabled.

« Selecting Auto Approve approves the objects automatically after the update, and then places the objects in
the approved workspace.

« Selecting Pre-flight allows a user to perform a test run of the update. When the user clicks 'Finish', the test runs
in the background. This will apply the operations selected, and then roll them back. Additionally an execution
report and an Impact Report will be generated. Temporary collections will also be created for the objects where
the operations were successfully applied, and for the ones were errors were generated. The availability of this
option depends on the user's system setup.

Note: Itis recommended to always run a Pre-flight test or to try applying operations to a small set of objects
before large quantities of objects are updated, as there is no 'undo’ functionality for bulk updates.

« Selecting Save configuration allows a user to save the configuration so that it can be used again.
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32 Save Operation Configuration

ﬁ {ETIM Article Groups)

-] Assets
r_=| Configurations
'r_=| Index Words
E] B ndate r_=| Merchandising Hierarchy
- B[] Suppliers
Steps Advanced -] Web Sites
1. Configuration Jp—
2. Operations Do nat run now

3, Farameters i i _ Mame
Auto Approve
4. Preview Create St Cancel
5. Advanced Pre-flight \ [
Save Configuration | IZI
Process Description: Bulk Update
Avalilable for object types | All e

Back Mext Finish Cancel

« Inthe Process Description field a user can write in a name that displays for the background process.

« The Available for object types limits the object types and nodes affected by the bulk update operations. First
select an object type from the dropdown, then click the ellipsis button (...) to select the nodes to update.
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33 Select Object Types

32 Bulk Update

[]an
Steps Advanced [ ] Business Unit Root
1. Configuration i
—eiEiE [ ] Do not run now
3+ Parametens
4 Preview [] Auto Approve . .
5. Advanced [ pre-flight
oK Cancel
[] 5ave Configuration -
Process Description: Bulk Update
Avalilable for object types
Back Cancel

« Click Finish to complete the bulk update configuration and start the operation(s) in a background process.

For more on monitoring bulk updates through a background process, see the Monitoring Bulk Updates topic in
this documentation.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 14



StiboSystems

Bulk Update Operations

There are a number of operation options available when performing a bulk update. Because more than one
operation type can be applied during a bulk update, and the order in which the operations are listed matter when
performing a bulk update, it is important to fully understand what each operation does.

Note: Ensure that the operations are listed in the order that they are needed to be performed. Operations are
performed from the top down. This means that operations further down the list have the potential to overwrite
previous operations.

The following sections contain explanations of each operation type available in the Bulk Update wizard.

Attribute values

Data Containers

Data Quality
Publishing
References and Links
Workflow

Run Business Rule
Send Republish Event
Set Name

Set Object Type

Operations are can be chosen in the Operations step of the Bulk Update wizard.
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$2 Bulk Update

Steps Operations
1. Configuration | Merge Amribute Vakes + '
rations . T
2. Ope Merge Attribute Values . into . E
3. Parameters ]
: Attribute values >
4. Preview
i *
5 Ady Data Containers L alues »
Data Cuality H
S
Publishing b
References and Links ¥
Workflow ¥

Run Business Rule
Send Republish Event
Set Mame

Set Object Type

Add Operation

Back Mext Finish Cancel

See the Running Bulk Updates topic within the Bulk Update documentation for more information on the Bulk
Update wizard.

For some of the operations, a user can specify a function in the Function editor. See the Using Function Editor
topic within the Attributes documentation for more information on writing functions.
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Attribute Values Operations for Bulk Updates

The following operations allow you to modify attribute values.

Merge Attribute Values

Copies the values from the first selected attribute to the other, in the current workspace, based on the parameter
settings. For dimension dependent attributes, the copy is performed across all dimensions or applicable
combinations of dimensions.

Verifying Attributes for Merge

This operation can also be started from System Setup by selecting an attribute, then right-click and select Merge
Attribute Values. For details about verifying the attributes before performing this operation, see the Merging
Attribute Values section of the System Setup / Super User Guide.

To merge attribute values for only some objects, go to the Search tab, and create Search Results of the objects to
merge. Then either click the Collections button to save the results as a collection (which can be used for repeated
updates), or click the Bulk Update button and click Next to display the Operations page and the following Merge
Attribute Values parameters.

Merge Attribute Values Operation

Operations

M | Mesge Atribute Vahes i
Merge |T-shirt Size E'I'shirtSizE]lo ve. Nt |Size (Size) e . E
Source Workspace: Main o
Cverwrite: ¥eep original values [
Merge Link Attributes: | Mo e

1. Inthe Merge parameter, click the ellipsis button (...) to display the Select Attribute dialog, choose the attribute
to copy values from, and click the Select button.

2. Inthe into parameter, click the ellipsis button (...) to display the Select Attribute dialog, choose the attribute to
copy values to, and click the Select button.

3. Forthe Source Workspace field, use the dropdown to select the workspace that holds the values to be copied
to the target, based on the other parameters. Values are always pasted into the Main workspace.

Consider the following example data, and assume we will choose to Overwrite existing values (as described
below). Selecting the Source Workspace = Main will result in writing the T-shirt Size value of S, while selecting
Source Workspace = Approved will write the XS value.
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€ 18210 M B rev.0.23 - Compare Workspa... -k

=- il Cotton T-Shirts A References || Referenced By |
.
E 18217 LE View: MergeValues '|
- 18213M 0 :
gEe I M— T —
I [T T-Shirts Sales Items
* Mame 13210 MB 13210 MB
> Bize all extra small
| > JT==hirt Gize Em WS

4. Forthe Overwrite field, choose an option to determine when to write to the target attribute. Validation errors
are displayed on the Preview page when a value cannot be modified.

Consider the following data and the effects of the options as shown in the Preview images below. 'T-shirt Size'
is the source attribute and 'Size' is the target attribute:

< products

E‘ ‘ Cotton T-shirts m References || Referenced By
- s210MB
- 1821218 View: SizeAttrs v|
| 18213M0 - |
E 18216 L O D * [Name * [T-shirt Size *> |S|2E »
[T T-Shirts Sales Items 18210  18210MB 5 small
15212 15212LE 5
15213 15213 M0 Medium
15216 1521610

» Keep original values means the source value is only copied to the target attribute when the target attribute
is blank. If the target attribute contains a value, the target value is not changed. Notice that the only value
changed in this scenario is for object 18212 L B, since the source object had a value and the target value was
blank. Since the other objects either had values for the target or the source was blank, none of them were

modified.
Preview
CObject > » |[Merge Attribute [Size] >
>
> LaoinMB id [small]
¥ Mew ILsrnall]
» Old
—153212LE
> Mew [5]
» id [Medlum]
— 18213 MO
» Mew [Medium]
>
— 18216 L 0 il
> Mew
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« Overwrite existing values means the source value overwrites the target value, except when the source
attribute is blank. If the source attribute is blank, the target value is not changed. Notice that two values
changed in this scenario: object 18210 M B had its value overwritten since a value existed for the source, and
object 18212 L B was overwritten since the source object had a value and the target value was blank.
Objects 18213 M O and 18216 L O both had blank source values, so the target values were not overwritten.

Preview
CObject > * |[Merge Attribute [Size] >
» old [small]
—18210 M B
» Mew [5]
> Old
—153212LE
% Mew |£5]
» oid [Medium]
— 18213 M 0
» Mew [Medium]
&
— 18216 L 0 il
> Mew

5. For Merge Link Attributes field, if the selected attributes are both used as an attribute on a reference, a
product classification link, or an attribute link, merging of those values are based on the Yes or No set in this

parameter, as well as the other parameters on the operation. This option is not relevant when values do not
exist on references for the selected attributes.

For example, consider the following values for the attributes 'Qty of Next Lower Package' and 'Qty of Next
Higher Package' on the Case to Child reference.

¢ SIS
E-(3 Collections A (] Products Referenced By

A (5 AllPPH
&8 @ Item References, Classification

- [ Backplate i
Fi- [ Baskets @ Packaging Hierarchy References
B [ Beds Reference Type: Case To Child

" ) Bottled Water Source vReference Type » | * Target » Oty OF Mext Lower Package * |Qty of Next Higher Package 3| »
» |T-shirt, case (LB) + (Case To Chid \y M 13212l [® 96 ry
» |T-shirt, case (L0) + (Case To Child M BasL0 24 b
» |T-shirt, case (MB) + (Case To Child \y . 13210 M B 3 ry
» |T-shirt, case (M Q) + Case To Chid \t}u M 18213M 0 b

Setting the operation parameters as 'Qty of Next Lower Package' for the source, 'Qty of Next Higher Package'

for the target, using the Overwrite existing values, and setting Merge Link Attribute = Yes results in this preview
of resulting values:

© Stibo Systems - Confidential - STEP Trailblazer 8.3 19



StiboSystems

Preview
Object » » [Merge Atiribute [QtyMNextHigherPackage] »
: T-shirt, case (L B) ESN Ei:iig:;}
: [Farrh=ER b Ell:l‘\' [181951(24)]
: T-shirt, case (MEB) Ede Eiiﬂgﬁg
>
; T-shirt, case (M O} Ede

For more information about attributes on references, see the Product Attribute Link Type section of the

System Setup / Super User Guide documentation.

Note: The Merge Attribute Values operation does not delete any attributes, it can only update values. If desired,
manually delete the source attribute once you confirm the merged data.

Set Value

Sets the value of the selected attribute based on a value entered manually or via a function.

Manual Values

1. Click the ellipsis button (...) on the first field and select the attribute that will be updated.

Note: The selected attribute dictates the label on the manual button. In the image below, the selected attribute
requires a text value and so the label is 'abc.' If the selected attribute is numeric, '123' is displayed, and so on

for each validation base type.

2. Since the manual value button is selected by default, enter the desired value in the '=' field. The value of the

selected attribute will be set equal to this manual value.

Dperations
Set Vale - i
City (City) | = |.-5.Hanta | abu: o

Add Operation

Function Values

1. Click the ellipsis button (...) on the first field and select the attribute that will be updated.

2. Click the 'fx' button to indicate a function will be used.

© Stibo Systems - Confidential - STEP Trailblazer 8.3
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3. Click the ellipsis button (...) on the '=' field to display the function editor.

4. Enter afunction based on the requirements that will resolve to the desired value.

Operations
Jration et Vake v
, -
Width (Width) - m 123 =
Auto Indent | Insert Template | Insert Attribute ID | iHighlighting
L)
W :| Finish Cancel
| | Evaluation Node Evaluate ™
| =
oK Cancel

See the Using Function Editor topic within the Attributes documentation for more information on writing
functions.
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Data Containers Operations for Bulk Updates

The options for Data Containers operations are below:

Update Data Containers

This operation allows users to run business actions on selected data container objects. When executing this
operation, users can filter which data container objects to work with by specifying a business condition and/or data
container type, before running the specified business action on those objects.

1. Runasearch for data containers based on the desired criteria, and run the bulk update by clicking the Bulk
Update icon.

2. Onthe'Operations' step of the wizard, click Add Operation, and select Data Containers > Update Data
Containers.

F*1 Bulk Update ¥
Steps Operations
1. Configuration Update Datz Contsiners ¥ '
2. Operations Data Container Type |GRDataContainer (GRDataContainer) .
3. Parameters Business Condition | AutoAppWithBRAfterCond (AutoAppWithBRAFterCond)
4. Preview Business Action AutoAppWithBRAppAction (AutoAppWithBRAppACtion)
5. Advanced

Add Operation

Back Finish Cancel

3. Inthe Data Container Type parameter, click the ellipsis button (...) and select the data container type this
operation should apply to. This is an optional selection.

4. Inthe Business Condition parameter, click the ellipsis button (...) and select a business condition to filter
eligible data container objects further. This is an optional selection.

5. Inthe Business Action parameter, click the ellipsis button (...) and select a business action to apply to the
data container objects upon execution of the bulk update. This is a required parameter.
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Data Quality Operations for Bulk Updates

The options for Data Quality operations are below:

Generate Match Codes

For this operation, a user needs to select which match code to use. Once selected, it will then generate match
code values for the selected objects of the bulk update.

Note: Collection objects should match to the match code object type and category.

Operations

Generate Match Codes ™ f
Match code:  |Find Similar Match Code (FindSimilarMatchCode) ‘

Add Operation

For more on match codes and how to create them see the Configuring Match Codes topic in the Matching and
Linking documentation.

Match Duplicates (apply matching algorithm)

DEPRECATED. Suggested to instead use 'Send Republish Event' to Event Processor configured to apply
matching using user's matching algorithm.

User will have to select which Matching Algorithm to use.

Will then apply the matching algorithm on selected objects of this bulk update—this includes generating a list of
possible duplicates and a score that indicates how identical the objects are. And if a golden record matching
algorithm is used it will also update golden record linkages and re-apply survivorship rules.

Standardize Address

This operation allows for different standardization actions to be taken on addresses by using the Logate solution. If
applicable, CASS (Coding Accuracy Support System) operations can also be performed to apply a stricter level of
address validation to US-based addresses.

Standardize Address bulk update operations are valid for execution on entities with flat attributes, e.g. Address
object types and address Data Containers (Data Containers with address attributes).
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I | Standardize Address W

e

Address Standardization Mode Cwverwrite Existing Standardized Address e

Renew address validations alder than (if 1850 1= Dave
left empty, this option is ignored) = ¥

Turn on CASS validation for US addresses [ ]

CASS Certification Report Event Processaor

This documentation topic describes the options available when configuring a Standardize Address bulk update
operation. For more detailed information on the overall Logate and CASS solutions, see the Loqate Integration
section of the Data Integration documentation.

Prerequisites
Before a Standardize Address bulk update operation can be run, the following conditions must be met:

« Users must be connected to a Logate server, either through a cloud API or local API

« The Address Component Model must already be configured. It is strongly recommended to configure this
component model using the 'Easy setup of Address Component Model' wizard. For more information, see the
Address Component Model section of the Logate documentation.

« Toview and use the CASS features, users must:

o Purchase a CASS license

« Be connected to Logate through a local API (CASS components will not work with a Logate Cloud
API)

« Bebasedinthe US, as CASS is not valid outside of the US

« Configure the CASS Address Component Model. For more information, see the CASS Address
Component Model topic in the Logate documentation.

Address Standardization Modes
Three options are available from the Address Standardization Mode dropdown list.

" | Standardze Address I
D
-l

Address Standardization Mode Overwrite Existing Standardized Address o

Cwverwrite Existing Standardized Address
Generate Hash Value Cnly
Dizable Address Standardization

Renew address validations older than (if
left empty, this option is ignored)

Turn on CASS validation for US addresses ==

CASS Certification Report Event Processaor
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« Overwrite Existing Standardized Address: Overwrites an existing standardized address by making a call to
Logate, which returns the latest standardized address and overwrites the existing one.

« Generate Hash Value Only: When this option is chosen, the business action will recalculate the 'Validation
Hash' value without making a call to Logate. The hash value is based on the address input fields only and is
calculated and maintained by STEP.

This option is used in cases when pre-standardized addresses, which are known to be correct, are imported.
Because the addresses are new, no hash value is present. When the 'Generate Hash Value only' action is run,
STEP generates a hash value and places it into the 'Validation Hash' field. The hash value lets STEP know that
the addresses are new, ensuring that they are not picked up and restandardized by STEP shortly after they are
imported. For users of the Logate Cloud API solution, this saves money by avoiding unnecessary calls to
Loqgate, since users are charged a fee for every call made to Logate.

Tree
£ (ADD_192254)
% (ADD_192265)

3550 George Busbee Pkwy rev.0.11 - Address

References || Referenced By || Matching || Status || State Lng[

» Gtate abe GA

s Etrest ahg 3550 George Busbee Plwy NW

» Walidation Hash abe -1618371087
Logate-161837 1087 < ?xml version="1.0" encod
2lgti=

- Disable Address Standardization: This option is primarily useful for users who import addresses in bulk,
either manually or by using an inbound integration. If a business rule is in place that runs a Standardize Address
bulk update on import, then selecting 'Disable Address Standardization' is a simple way to temporarily turn off
automatic address validation on import. This allows users to validate the addresses later.

Renew Address Validations

The checkbox option Renew address validations older than allows for addresses older than a designated
number of days to be revalidated. This is useful in case an address was validated an extended period of time ago
and the address may no longer be valid. The default number of days is 160. The field is disabled by entering the
value'0.'

I | Standardize Address W

Address Standardization Mode

.-T\.
COwverwrite Existing Standardized Address e E

Renew address validations older than (if
left empty, this option is ignored)

-

160 Days

Turn on CASS validation for US addresses

CASS Certification Report Event Processar

[

STEP determines the age of an address by the value present in the 'Validation Time' field.
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Tree € 3550 George Busbee Pkwy rev.0.11 -
ﬁ (ADD_192268) "~ References || Referenced By || Makching [-
-4} (ADD_152259) < fresults
-4} (ADD_192272) = fresults>
¥ (ADD_215171) =flgt=
-.#y [B550 George Busbee Pkwy| » Validation Time abe; [2017-06-09 09:41:15
¥ ADD_BLANK 1> Zio 122 017

Important: For users of the Logate Cloud installation, care should be exercised when using this functionality.
Since all addresses older than the specified time period will be revalidated, each additional validation will make a
chargeable call to Logate.

CASS Validation
Two CASS address validation options are available on the Standardize Address dialog.

M| Standardze Address w
Address Standardization Mode Owerwrite Existing Standardized Address o

Renew address validations older than (if 160 Davs
left empty, this option is ignored) z ¥

Turn on CASS validation for US addresses [ ]

CASS Certification Report Event Processor

« Turn on CASS validation for US addresses: If checked, all addresses are sent for standardization to the
Loqate Local server integration and also validated against CASS data.

« CASS Certification Report Event Processor: If you would also like a CASS certification report generated
after using CASS validation on an address, click the ellipsis button (...) and select the relevant CASS
certification report event processor from the 'Select Event Processor' dialog. For more information, see the
CASS Certification Report Processing Plugin Parameters and Triggers section of the Event
Processors documentation.
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Publishing Operations for Bulk Updates

Several bulk update operations are available for publications in STEP.

Bulk update operations for publications can be accessed either by selecting File > Bulk Update > Run Bulk
Update, or by right-clicking on a publication group object, publication object (pictured in the below screenshot),
section object, or DTP document in the publication hierarchy and selecting Run Bulk Update.

e Link asset
FH-T] Index Words
m-[7] Merchandising Hierz Ee=p P penelEn e

&[] Suppliers Update plan from actual page...
-] UNSPSC14C

- UNSPSC17 & Cut

B[] UNSPSC18 Copy

--i Entity Root Paste

-0 GDSN

"-_J GDSM Receiver Paste Link

--[0) GDSN Receiver Roc

-5 Promotions . Delete

=@} Publications B2 Duplicate

- Templates

-8 standard Public Search Below

- Acme Tools ) _
w0 Acme Toys Financial Report
-0 Acme Clothi @ Export Data Below
- @ Acme Party

Export to Transfer Package
-G Flatp
ﬁ WeblUI — Reapply Layout Rules
=B TempwWebWPu Check for update needed...
&I Primary Product N au Update...
#-03 Collections | Run Bulk Updat
#-E3 eCatalogs un bulk Update

Once the Bulk Update wizard is launched, the publishing options are accessed in step 2 of the Bulk Update wizard
(Operations) by selecting 'Publishing’ from the operations dropdown menu.
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$2 Bulk Update

Steps Operations
1. Configuration i
fig Merge Attribute Values

2. Operations .
Attribute values > |Into :

3. Parameters \

. A

4. Preview '\.,' e

= e Publishing : Start flatplans in STEP Workflow
References and Links  * Remove flatplans from STEP Workflow
Worlkflow : Check publication document for needs update
Fun Business Rule Update publication docurment

Send Republish Event
Set Mame
Set Object Type

Add Operation

Back Mext Finish Cancel

Start flatplans in STEP Workflow

Adds all Flatplanner spreads (planned pages) in the selected publication group, publication, or section into the
specified Flatplanner workflow. The bulk update is initiated by right-clicking on the desired publication group,
publication, or section. A selection of planned pages can also be chosen for bulk initiation into a Flatplanner
workflow by multi-selecting them and going to File > Bulk Update > Run Bulk Update.

The desired workflow is chosen from the "Workflow' dropdown list. Note that only workflows valid for planned
pages will appear. Flatplans that are already in a workflow are not affected.

— I —
Qperations Operations
Start flatplans in STEP Workflow = : Start flatplars in STEP fow ¥
Workflon | Flatplan group assignment 8.0 Lo Workfiow  |Flatplan group assignment 8.0 =
Process Note —p ERNRRAIAN F|atplan group assignment_8.0
FlatPlanner_Legacy_PreTB
latplanner Pre-8.0

Add Operation Add Operation

After selecting which workflow to initiate the Flatplans into, a 'Process Note' can be entered to name the resultant
background process.
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Remove flatplans from STEP Workflow

This option is legacy functionality (pre-STEP 8.0) from when only one workflow at a time was allowed for planned
pages. There is no ability to select a specified workflow.

A 'Process Note' can be entered to name the background process that takes place.

Operations

it

Remove flatplans from STEP Workflow
’VF'rn:n:ess Mote |Removed

Add Operation

Check publication document for needs update

This checks all actual pages saved to the selected publication / section to determine if updates are needed. A page
will need an update if any elements mounted on the page (for example, attribute values or image references) have
changed in STEP since the page was originally saved to STEP.

Operations

|' Check publication dooument for neads update + —

BKX

Add Operation

Checking documents for updates is only useful for AutoPage and Flatplanner publications. Since near-identical
functionality can be accessed from other locations in the workbench (including right-clicking on a publication or
section object in the Tree and clicking 'Check for update needed..."), the use cases and applications for checking
documents for updates are detailed in the following publishing-specific topics instead:

« Updating Documents in AutoPage in the STEP AutoPage documentation
« Updating Documents in Flatplanner in the STEP Flatplanner documentation

Update publication document
When updating a publication document there are two options to choose from:

1. Update all contents of section: This updates all information on all actual pages saved to the selected
publication, section, or DTP document.

2. Update only the following items of the selection: Choosing this allows for the selection of specific items to
be updated on the actual pages, such as attributes, image references, and table types.
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32 Bulk Update

Steps Operations
1. Configuration | Update publication document ! [
~ T
2. Operations (@) Update all contents of selection E

3. Parameters
(") Update only the following items of the selection

4, Preview
5. Advanced Add...
Remove
Remove All

Obtain values from fransformed tables, preserve local table styling and structure

Add Operation

Back Mext Finish Cancel

The 'Update publication document' bulk update option functions almost identically to the Update feature that is
directly accessed by right-clicking on publication, section, or DTP document objects in the Tree. The selections in
the 'Operations' dialog pictured above are identical to those in the 'Update contents of documents' dialog that is
accessed through the 'Update' feature. Because of these similarities—and because the 'Update' feature is more
commonly used than the bulk update feature to update documents—this feature is detailed in the STEP'n'design
documentation instead. See Updating Documents From the Workbench in the STEP'n'design
documentation for more information.
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References and Links Operations for Bulk Updates

Bellow are all options for adding references and links:

Add Attribute Link

When choosing this object, the selected attribute will be linked to the collection of valid objects.

Operations
Add Attribute Link = T
! )
’V Attribute: | (BatteryType)
Add Operation
Back Mext Finish Cancel

If an attribute is on an object, it is also viewable by going to the References tab on the object, and selecting the
flipper 'Linked Attributes from Product Hierarchy'. If there is an attribute that does not have an edible field (or link)
to store data, choosing this option adds a link to an attribute, and allows data to be stored.
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Tree Flashlights Items rev.0.5 - References
E'ij Primary Product Herarchy A (|| Images & Documents || Commercial || Tables || Cateqory Profile || Proof View Sta State Log Tasks
[ Products | Product ” Product Variants ” Sub Products References [ Referenced By \
Ee-{ Appare! 5 TAddndex Word A
[#)-[[7] Footwear © Publations
Bty D >N |
E-[T) Hardware ame
=8 E Tools |7 |Link to Publication or Section
(=) Task Lighting @ Linked Attributes from Product Hierarchy
= EFlashlights (DisplaySequence) * {Completeness Score > [ID > Name > |(Product Variant Priority) * |(Value2)
E ‘WBM ¥ BatteriesIncluded  (BatteriesInduded)
- {8 (111204) |
H]
E 2086 BatteryType (BatteryType)
E 0883 ol v Brandhame (Brandhame)
E LIGHTS-10 h - BrandOwner (BrandOwner)
[T Flashlights SalesT w |[| Brightness (Brightness)
Tree Flashlights Items rev.0.5 - References
E'ij Primary Product Herarchy A (|| Images & Documents || Commercial || Tables || Cateqory Profile || Proof View Sta State Log Tasks
[ Products | Product ” Product Variants ” Sub Products References [ Referenced By \
Ee-{ Appare! 5 TAddndex Word A
[#)-[[7] Footwear © Publations
Bty D >N |
E-[T) Hardware ame
=8 E Tools |7 |Link to Publication or Section
(=) Task Lighting @ Linked Attributes from Product Hierarchy
= E Flashlights (DisplaySequence) * {Completeness Score > [ID > Name > |(Product Variant Priority) * |(Value2)
E ‘WBM ¥ BatteriesIncluded  (BatteriesInduded)
R [T
H]
E 2086 BatteryType (BatteryType) I
E 0883 ol v Brandhame (Brandhame)
: E LIGHTS-10 Y6 w BrandOwner (BrandOwner)
[T Flashlights SalesT w |[| Brightness (Brightness)

For more information on linked attributes see the Attribute Links topic in the System Setup / Super User
Guide documentation.

Add Reference or Add Reference By

Add Reference and Add Reference By both have similar configurations for bulk updates. Performing this action
for Add Reference adds a reference of a specified type to a target. Alternatively, for Add Reference By this

adds a reference from a target to the source. It is important that the objects that are to receive the reference are
selected before the bulk update is run.

First, select a reference type, and then choose a target (object) or Source that is in accordance with the selected
type.
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'

Type: |5upp|ier Link (SupplierLink) ||Z| Type: |Supplier Link (SupplierLink) "Z'

Target: |F‘ruducts {ProductsGaloreProducts) |E3 Source: |E|3D Display Rack (22208) |
Add Operation Add Operation

When finished, a user should see the added type reference to the target. An example using Add Reference is
below:

(=[5 Flashlights
=I-Jjili Flashlights Items
- (179901)
| (179912)

129707 rev.0.6 - References

=[5 Flashlights
=I-Jjili Flashlights Items
™ (179901)
- (179912)

Similarly, a user could specify a function in the function editor by selecting the 'fx' button and clicking the ellipsis
buttons to bring up the editor.

Again, an example using Add Reference is below though it works the same way for Add Reference By:

After selecting the 'Type' of reference, a user opens the function editor and types in the function needed. In this
case there is an attribute on the item called 'Product Image' that holds the ID of an image asset.
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129707 rev.0.7 - Product

Tables || Category Profile || Proof View || Status || State Log m
Product I Sub Products ” References " Referenced By " Images & Documents
@ Description
Mame *| ¥ |Value
* D 129707
* Name 129707
* Dhiject Type Ttem ]
* Revision 0.7 Last edited by USERL on Mon Sep 12 0, Operations
> Wpproved x Mever Been Approved Add Retaene ™
* [Translation Mot Translated Type: |Primary Product Image (PrimaryProductImage) | ...
» Parent #. Flashlights Ttems Target: | prodval{"Product Image™) abe

> Path £ Hardware | Tools | Task Lighting | Flashli
Product Image abe (134312 I Add Operation

—
W

When the bulk update is run, it uses the ID in the attribute to call forth which asset to put on the Primary Product
Image reference.

129707 rev.0.7 - References

Tree

E*E Flashlights ""* Category Profile || Proof Wiew || Status || State Log | Tasks

-l Flashlights Iter Referenced By ” Images & Documents ] Commercial Tables
a (173301) Product ” Sub Products ] References
a (179917
-\ 129707 3 Image References A
E 170997 Reference Type w| » [Target ¥ [Thumbnail >
- ™ 129999 » |Brand Mame Loge  + B
-\ 134852 » |Tlustration + [k
ﬁ 134353
™ 134855 || > |Primary Product ... + % /W] MagLiteFlashlight

> el 0 uw M | W

Automatic Classification

Classifies the selected objects automatically according to a set of rules. To perform this operation, a user selects
the following:

« Arule set which is selected using the ellipsis button.
« The context in which the rule conditions should be evaluated.

« If'Use approved rule set' is checked, then only approved rule sets can be used for this operation.

See Automatic Classification documentation for more information.
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Industry Classification Synchronization

This operation allows users to reclassify products to newer eCl@ss, ETIM, or UNSPSC versions. When
executing this operation the specified product to classification link type will be overwritten with the new version of
the classification hierarchy for all updated products.

1. Runasearch for any products that need their classification links updated to a newer eCl@ss, ETIM, or
UNSPSC classification hierarchy, and run the bulk update by clicking the Bulk Update icon.

2. Onthe'Operations' step of the wizard, click Add Operation and select References and Links > Industry
Classification Synchronization.

F5] Bulk Update X
Steps Operations
1. Configuration - | Industry Classificztion Synchronzstion w1 -
2.0 tions T
= Industry standard matcher eClass v E
3. Parameters
4. Preview Source dassification root eClass 9.1 (eClass_3.1)
5. Advanced Target dassification root eCl@s=9.1.1 (eClass 9.1.1)
Product to dassification link type |eClassSEG (eClass5EG) m

Add Operation
Back Mext Finish Cancel

3. IntheIndustry standard matcher parameter, select the relevant industry standard from the dropdown list.

4. Inthe Source classification root parameter, click the ellipsis button (...) and select the classification root
node for the original industry classification version.

5. Inthe Target classification root parameter, click the ellipsis button (...) and select the classification root
node for the new industry classification version.

6. Inthe Product to classification link type parameter, click the ellipsis button (...) and select the product to
classification link type the products use to link into the classification hierarchy.

Link Asset to Classification

This allows users to link assets to a specified classification.

1. Select the assets that need to be linked, and run the bulk update by going to File > Bulk Update > Run Bulk
Update

2. Inthe Wizard select References and Links > Link Asset to Classification

3. Select the classification the asset should be linked to and run the bulk update.
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i 7] Installation Manuals

E} |j Logos

StiboSystems

rj Illustrations

Operations

EI r_=| Brand Logos

=- ||'.|5|'.|

|.5.. Evian Logo

Link Assst to Classification =

Classification = |Product Logos {ProductLogos) m

&

|.5- StiboSystems-
-rj Product Logos

[+ 7] MSDS Sheets

Add Operation

B[] Owners Manual

4. Assets should now appear under designated classification folder.

|‘_=| Tlustrations

|j Installation Manuals

f] |j Logos

E| r_=| Brand Logos

I il lngd Acme

T Evian Logo

: LI log= StiboSystems-logol
----- r_=| Miscellaneous Logos

----- r_=| Miscellaneous Logos

El r_=| Product Logos

[T Owners Manual

]

For more information on how to use the function editor option, 'fx', please see the Using Function Editor topicin
the System Setup / Super User Guide documentation.

Remove Attribute Link

This option removes the selected link to an attribute. Note that the selected object should have a direct link to the

attribute.
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Tree Flashlights Ttems rev.0.5 - References
Elij Primary Product Hierarchy A (|| Images & Documents || Commercial | Tables || Category Profile || Proof View Sta Chate Log Tasks
ED Products | Product ” Product Varianks ” Sub Products References Referenced By l
-] Apparel > Aad dex Word "
..
H {7] Footwear 9 bl
-7 Safety
H *
([T Hardware D
EHj Toals | |Link to Publication or Section
= Task Lighting © Linked Attributes from Product Hierarchy
= E Flashlights (DisplaySequence) > (Completeness Score > |ID » [Mame » |(Product Variant Priority) > |(Value2)
E ‘mm ¥ Batteriesincluded (Batteriesincluded)
g
¥
ﬁ 20862 BatteryType (BatteryType) I
ﬁ 0883 gl . BrandName (BrandMame)
- uemsn ([ v BrandOwner  (BrandOuner)
1j Flashllghts Sa|esI LA Erlghtness {Erlghtrless}
\j
Tree Flashlights Items rev.0.5 - References
Elij Primary Product Hierarchy A ||| Images & Documents || Commercial || Tables || Cateqory Profle || Proof View Status State Log Tasks
EE Products | Product ” Product Variants Sub Products References Referenced By }
I [7) Apparel > Rad ndex Tord "
..
H {7] Footwear o B
-] Safety
H * #
E-[5) Hardware D |Name ‘
EE Toals | |Link to Publication or Section
= Task Lighting © Linked Attributes from Product Hierarchy
= E Flashlights (DisplaySequence) » (Completeness Score 3 [ID » Name > |(Product Variant Priarity) > [(Value2)
E .mm f Batteriesinduded (BatteriesInduded)
R ST
-]
8 20852 BatteryType _ (BatteryType)
E 0883 ¥ v Brandiame (Brandhame)
: ﬁ LIGHTS-10 A v BrandQwner (BrandCiwner)
E F|aSh|IghtS SB|ESI W b Enghtﬂess {Bnghtﬂesﬂ}

Select the attribute that is to be removed by clicking the ellipsis button, and run the bulk update.

. Operations
Remove Attribute Link
’Vﬁ.ttribute: (BatteryType)
Add Operation
Back Mext Finish Cancel
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Remove Reference
This removes references to a specific target or all references of a specific type.

To remove all references of a specific type select the reference type, and then check 'Remove All'.

Operations
[ Remove Reference | Tor] ™
. :
Type: | (Ilustration)
Target: IE f
W
Add Operation
Back Mext Finish Cancel

To remove references of a specific target select a reference type, and then select the target.

32 Bulk Update

Steps Operations

1. Cenfiguration Remove Reference = ] ™

2. Operations Type: |(Hlustration)

3P =T

SIEMELEs Target: |ProductFolderlcon (107499) m i
4. Preview I I_
Remove all targets
5. Advanced O d =
Add Operation B

‘ask Lighti
= Flashii Back Mext Finish Cancel
- JTEshng ms _ E
P LED Flashlight * | (Tlustration) + H.IE" ProductFolderIcon _

This can also be done by specifying a function in the function editor. For more information on how to use the
function editor option, 'fX', please see the Function Editor topic in the System Setup documentation.

After selecting the 'Type' of reference, a user opens the function editor and types in the function needed. In this
example there is an attribute on the item called 'Product Image' that holds the ID of an image asset.
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Tree
-5 Hardware
E}i Tools

-m

Eli Task Lighting
([ Flashlights

Flashlights Items

-\ (173301)
-\ (179312)
Bw
- | 129997
| 125538
- | 134852
- | 134853
| 134855
- | 13485
- | 134857

i 134858

129707 rev.0.7 - Product

Tables || Category Profile || Proof View || Status || State Log || Tasks

SliboSystems

Product l Sub Products " References " Referenced By "

Images & Documents l

?

MName > |Value
»ID 129708
> Name 129707
» Dhject Type Ttem _
> Revision 0.7 Last edited, Operations
» pproved 3€ Never Beer
» Translation Mot Translated | || Type: |Pruduct Image (ProductImage) ||Z|
» Parent fi Flashlights Item || 7 e, ||:|rudva|{'ProductImage‘] |
> Path # Hardware | Toc [JRemove al trgets
- Product Image abe (134812

Add Operation

 Back | MNext | Fnsh || Concel |

When the bulk update is run, it uses the ID in the attribute to call forth which reference to remove from the Product

Image reference.
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Tree 129707 rev.0.7 - References
3"iT35kL@hﬁ”Q ~ ||| commercial || Tables || Category Profile || Proof View || Status || Statelog || Tasks
E}iFIashIights | Praduct ” Sub Products ] References [ Referenced By ” Images & Documents ]
=-Jilil Flashlights Iter ] "
E ﬁi:ﬁ; _F‘.Eferen::e Type w| » [Target ¥ [Thumbnail
E- > |Brand Mame Loge 4 (B2
- ™ 129997 > [Tlustration +
- P 120999 > |Primary Product ... + [Bg]
ﬁ ﬁ:i y |> Productlmage  + |k, | @] MagLiteFlashight '

lware 2
lools
[T| Task Lighting
=T Flashlights Reference Type w| > [Target * [Thumbnail
Flashlights Ite
E“ =sig ms > |Brand Mame Logo  + |
| (179901)
™ (179912) » |Tlustration +
§> E- * |Primary Product... + n v
- 129997
: * |Product I +
i N 170000 roguet maee n‘

Set Product to Classification Link Type

This assigns a new object type and a classification link type to the selected classifications. To do this a new object
type needs to be selected first, and then the relevant classification link type needs to be selected.

Itis important to note that the object types needs to be made valid for the classification type.

System Setup ( System Setup ¢

(] UNGPSC m @ E}E Alternate Cléssiﬁaﬁons m Log
B[ UNSPSC14 ] Al Supplers Opecsdftis Ot
1j UNSPSC18 v 1j Alternate Classifications s > heme
Eij D ¥ Name 1j AssetRoot _— -
=8 E WebsiteRoot > Plebsjtel Plebsitel {7 Configurations Root » MerchandisingHierarchyRoot  Merchandising Hierarchy
..... - Cassitieh R ’wlebHierar - ’wleb SeslE ij Cl@ss Folder » MerchandisingHierarchyl  Merchandising Hierarchy 1
E {7 Weblevell 1j ETIMG Article Groups Type _
[ et ¢ fareis T g e e G Tpe
----- [ Weblevel3 D > Name - GPC Root 0 > [Name
-] Assets I » Classification 1 user-type root Alternate Classifications l {7 Index > Classification 1 user-type root Alternate Classifications
- Basic Obiect Tvoes *|add Paret i [ 7] Lookup Table Root |* | Add Parent
= [ Herbendsing ey Ror]
¢ 71 Department
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Once validity is checked, a user can choose a new Object type and a new Link Type. As seen in the example
below, the items under the WebHierarchyRoot with the Website Link are now going to be of the object type
'Merchandising Hierarchy Root' with the MerchandisingLink type.

$2 Bulk Update

Steps Operations
1. Configuration Sat Product 1o Classication Link Type ¥
2. Dperations Mew Object Type: |Merchandising Hierarchy Root (MerchandisingHierarchyRoot)
3P ter
SEMELErs Mew Link Type: Merchandising Link (MerchandisingLink)
4. Preview
5. Advanced
Add Operation
Mext Finish Cancel

7] Assets WECCGEGD M | Sub Products || References || Referenced By || Images & Documents || Tables [_5
E]r_=| Classifications % Description

([T Office Documents
[ TOfficeDoc

----- [Z] Merchandising Hierarchy 1

Mame ¥ * |[Value

Wehsite1

D

$ Bulk Update

r_=| Configurations

H Ste Preview

r_=| eClass 8.0 ps

{7 eClass 2. 1.0 -

H [0 eClass ) 1. Configuration Object > » |Set Object Type MerchandisingHi, .. *
[#-{Z] ETIM 5 Article Groups 5 At . i

1j ETIM & Articke Groups » Operations N od ObjectType=\Web Hierarchy Root,

! 3, Parameters | hebsitel LinkType =Website Link

E' GRC a . N New ObjectType =Merchandising Hierarchy
-7 Index Words Preview Root, LinkType=Merchandising Link
- {T] Merchandising Hierarchy 5. Advanced < N
B[] Suppliers

r_=| LINSPSC Back Finish Cancel

Unlink Asset from Classification

Selected assets will be unlinked from specified classification. A user needs to select the classification using the
ellipsis button where the assets are to be unlinked.
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$2 Bulk Update

Steps Operations

1. Configuration
2. Operations

3. Parameters

Unlink Asset from Classification =
Classification = |Ilustrations (TlustrationRoot) ||... p

4, Preview
5, Advanced

Add Operation

Mext Finish Cancel

Tree TruckIcon rev.0.1 - References
7] Assets ] [M] Referenced By || Status [mm

-] Icons & Classifications
----- & | BlueTrudkIcon 0 5 Marme > |Object Type > |Revision
""" # [conRoot lcons lcons 0.2 Last editec
""" » [lustrationRoot Tlustrations Tlustrations 0.1 Last editec
-] Hustrations > |Link to Classification
----- || Pens o
----- | ProductFolderIcon b 4 Bu.- Update
----- iy Producticon
----- W | STEPReferencesTab
----- & | TruckIcon
B[ Installation Manuals 1. Configuration Chject » * Unlink Asset from Classification >
[ 7] Logos 2. Operations LTruckImn old 2 links
[#-[T] MSD5 Sheets 3, Parameters » MNew 1links
[#-[T] Owners Manual 4. Preview
-] Product Images 5. Advanced
~[] Product Videos e »
- 7] Classifications
-] Configurations — Finish Cancel

This can also be done by specifying a function in the function editor by clicking the 'fx' button. For more information
on how to use the function editor option, 'fX', please see the Function Editor topic in the System Setup
documentation.

A user opens the function editor, and types in the function needed. In this example there is an attribute on the item
"BlueTrucklcon" called 'Asset Keywords' that holds the ID of the lllustrations classifications folder. The user in this
case no longer wants 'BlueTrucklcon' to be in the lllustrations classification folder.

Name >[5 e
> 120833
ueTruddeon

> Revison & Lestedted by USERL on Mon Nov 21 114119 E5T 2016
> horoved 1€ Last Approved on Tus Sep 13 11:56:59E0T 2016

ot Transsted

> path lassi n 1 root/Assets/Icons/BlueTrucklcon

H> contentn Language=Language Root, Country=Col

> Paset Gbiect Type 7 Ton
> [calaoted Asset Fie Name | 4 120833 BlueTrucklcon
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If the user wishes to remove this Asset from the lllustrations folder using the 'fx' function, they would need to type in
the ID of the attribute that holds the value that they want to get rid of. In this case Prodval("Asset Keywords").

Nt | [ o | [ Gl
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Workflow Operations for Bulk Updates

The following options are actions that take place with workflows:

Claim

Workflow tasks are assigned to user groups where individual users in those groups can then claim the task for
themselves from the group. As a user, to claim a number of tasks at once, select a workflow from the dropdown
menu and then select the required state from the dropdown list.

Operations
Claim =
STEP Workflow: | Order Process v E
Current 5tate: | Confirm Data Y

Add Operation

For more information on claiming bulk updates in workflows see the Bulk Update Operations for Workflows
topic in the Workflows documentation.

Initiate items in STEP Workflows

This initiates any objects that the bulk update is performed on in the selected workflow, assuming that the objects
selected are valid for the workflow. To perform this action, select a workflow from the dropdown list and enter the
process note / background process note.

Operations
Initiate items in STEP Workflow
Choose a Workflow: | Clerical Review e
Process Mote: Initiating Items in Clerical Review WF

Add Operation

For more information on initiating items in a STEP workflow via bulk updates see the Bulk Update Operations
for Workflows topic in the Workflows documentation.

Remove items from STEP Workflow

This removes all objects from one state in a workflow. Remove objects by selecting the workflow and entering in a
process note for the background process that takes place.
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Operations
Remove items from STEP Workflow T
Choose a Workflow | Clerical Review e
Process Mote Remove all items from Clerical Review

Add Operation

For more on how to remove items from STEP Workflows using bulk updates, see the Remove Objects From
Workflows topic in the Workflows documentation.

Trigger STEP Workflow Event

This allows a user to move an task from one state to another state. This can be performed by selecting a workflow,
selecting the desired state in the workflow, and then choosing the event that needs to be triggered. A process note
can also be added.

Operations
I | Trigger STEP Workflow Event T
STER Workflow: |Lead Pipe Plumbing Chedk w E
Current State: |Lead Free o
Event: Approve v
Process Mote:  |All objects in Lead Free state are approved

Add Operation

For more on triggering STEP Workflow events, the Bulk Update Operations for Workflows topic in the
Workflows documentation.
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Run Business Rule Operation for Bulk Updates

This runs a business rule on the selected objects. To run this business rule condition needs to be selected first, and
then a business rule action needs to be selected. When the bulk update is run, it will then evaluate the business
condition, and if it equates to 'true’ then the selected action will take place.

Alternately, if there is not a condition that needs to be applied, this field can be left blank and only a business action
needs to be selected.

______________________________________________________________________|
Operations

Run Business Rule ™

€

Business Rule Condition [LOV_ID_vs_Value (LOV_ID_vs_Value)

Business Rule Action Set Assignee (Set Assignes)

Add Operation
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Send Republish Event Operation for Bulk Updates

To perform this, a user will have to select a receiving processor to send the republished event to. It could be an

Event Processor, Outbound Integration Endpoint with an event queue, or an Event Queue directly. This option is
the same as selecting 'Republish' on one of the receiving processors. A republished event will then be sent to the
event queue of the selected processor for all objects in the bulk update.

System Setup
- 5] Delete LOV

- (7] Delete Prod Ref redo

- (7} Delete Product References

- [5 DimDepLOV

-7l Downstream Data_Event-base
- 5] Downstream Data_Object-Bas
- () EmptyValues

ﬂ Event Processor

- [5 LoV Definitions

- (2l LOV Value Update On Prods

ﬂ Ml

| Cutbound Inteqgration Endpoint ]

Item Attribute Change - Configuration
Background Processes || Statistics || Error Log Excerpts

Configuration [

Log || Status

Event Triggering Definitions

Event Actions: | Forward Rewind Purge Republish

* Days to retain events 0

* MNumber of events to batch 1000

* Mumber of event batches to incude per delivery |1

* Queue Status Fead Events

* Unread events (approximated) (2016-09-13 12:37:37)

~ M
-3 om Steps Operations > [Post-Proces
1, Con tion Mone
i | Pua 5 ﬁg"_a Sand Republish Event # ,’
Pu Operations Receiving processor;  |Item Attribute Change (TtemAttributeChange) m
[ JRE|  3.Parameters P
-9 5el 4 Preview
Tel ¢ advanced Add Operation
i

System Setup
-5 Delete LOV

-7l Delete Prod Ref redo

-7l Delete Product References
[ DimDepLOV

-7 Downstream Data_Event-base
- [5] Downstream Data_Object-Bas
- () EmptyValues

ﬁ. Event Processor

-5 Lov Definitions

-] LOV Value Update On Prods
ﬂ Matchrodeprocess

-7 Mongol

- [5 OIEP sample

- () Outbound_GDSN

A Pklir el amE s mlmTER

Background Processes || Statistics

| Cutbound Integration Endpoint

Item Attribute Change - Configuration

Error Log Excerpts
Configuration [

Skatus

Event Triggering Definitions l

& Event Queue Configuration
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Event Actions; | Forward Rewind Purge Republish
» Days to retain events 0
* Mumber of events to batch 1000
» Mumber of event batches to indude per delivery |1
* Queue Status Read Events
* Unread events (approximated) (2016-09-13 12:34:45)
Edit Configuration
@ Qutput Templates
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For more on republishing see the Event-Based OIEP Forward, Rewind, Purge, and Republish topic in the
Outbound Integration Endpoints section of the Data Exchange documentation.
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Set Name Operation for Bulk Updates

This sets the name of the object on which the bulk update is run. A user can either enter the name manually, or
specify a function in the Function editor for naming the object.

Operations
'
’VNamE: Red Flashlight %

Add Operation

See the Using Function Editor topic within the Attributes documentation for more information on writing
functions.

To create a name using the editor, it is often attributes on an item that are concatenated to make the name. For
example, in the image below there are two attributes that are populated that will be set to create the name of this
flashlight: 'Primary Color' and 'Brand Name'.
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129707 rev.0.7 - Product
Commercial |Iables Category Profile | Proof View §I:al:us| State Log || Tasks

Product Sub Products References
Mame > Value
* 1D 129708
* Ohject Type Item
* Revision 0.7 Last edited by USERL on Mon Sep 12 14:59:21 EDT 2016
* \Approved x Mever Been Approved
* [Translation Mot Translated
* Parent F Flashlights Ttems
* Path F Hardware | Tools | Task Lighting | Flashlights | Flashlights Items
> WWW # |Hrhtip: ffwww . stibosystems. com

Batteries Incuded
Primary Color

Mame

* Brand Owner abe
* Brand Mame abe Beaming Glow Light

By concatenating these two attributes together, it is possible to make a name for this flashlight item.

. Operations
I
’Vhlame: | Concatenate(Prodval("PrimaryColor™), ™ *, Prodval(BrandMame")) | |E|
Add Operation Prod [ ) Sub P:;nducts ” FI?:eFerenceslil ” I Rel
7
Marne * |Value »
* 1D 129708
» Mame Black Beaming Glow Light
> [Object Type Ttem
* Revision 0.7 Last edited by USERL on Mon Sep 12 15:26: 17 EOT 2016
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Set Object Type Operation for Bulk Updates

Changes the object type of the object on which the bulk update is run. You can select a specific object type or
construct a formula expression. Selected object type should be valid under the parent of current object.

_ Operations

Set Object Type ™

Object Type: | Levell 1Ir| IZl oY

Add Operation

See the Using Function Editor topic within the Attributes documentation for more information on writing
functions.

To set the specified object type using a formula expression, the user needs to select the 'fx' button and then click
the ellipsis button to bring up the function editor. Enter in the appropriate function, and then proceed through the
editor. The example below there is an attribute on the item called 'Attribute C' that holds the ID of an object type.

Tree Flashlight Camping rev.0.1 - Product
Publications 2 m References || Referenced By || Images & Documents || Commercial || Tables | Proof View || Status | Statelog || Tasks
Primary Product Higrarchy & Description
EPmducts Mame | |Value >
-] Apparel
EI Footwear » D FlashlightCamping
--r_=| Safety > Name Flashlight Camping
B Hardware > Object Type Fl-Item
(=5 Toals —
5 Task Lighting > Revision WBIES 33 Bulk Update
¢ [T Flashlights » Approved Mey .
HE kL = X ey stens Operations
iyl Flashlight Camping » (Translation Mot Tra -
Al {5 Anvis Y - b L Configrafon St Object Type ¥
-5 Dl : k| - re=cios . o [
-5 High Quaity Dri @ Sales Item Marketing Descriptions 3, Parameters Object Type: | prodvalCAtrute)
[#H-[I Doors and Doorknobs - Item Manufacturer Information 4, Preview
-1 Displays ® ; = ] Add Operation
t¥)-{I) Furniture Name s[> alue Back Next | Finish Cancel
-7 Automotive : = -
-5 Ruildinn Prodirts » e Jtem )

When the bulk update is run, it uses the ID in the attribute to determine what object type the item should be set to.
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m Flashlight Camping rev.0.1 - Pr

i Footwear L ml ReFerences_] Referenced By || Images & Documents || Commercial [_
i safety ¢ Oesoten
.. Hard
= i Araware Mame > | » Value ¥
=T Tools

E‘i Task Lighting * D FlashlightCamping

' "i Flashlights > Mame Flashlight Camping

G-\ Flashiight Camping. || 50 ecr 7y pe [tem

-] Anvils = .

i Drills * Revision 0.1 Last edited by USERL on Tue Sep 13 10:38:39 EDT 2016

[+ High Quality Drills > Approved 3€ Never Been Approved
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Monitoring Bulk Updates

When a user completes the Bulk Update wizard, the Background process status dialog displays. This allows a
user to monitor the status of the bulk update that was created.

Click Go to Process to display the Background Process tab where there is additional information about the
process execution.

Al :Q:l Autopage Batch Service
-7 BGP
£ Bulk Update (2)

- #5 Queued Processes

(2)

1]

% Active Processes
E}%ﬁ Ended Processes (2)
é:% Bulk Update

ﬂ% Bulk Update

485 Bulk Update
é:% Bulk Update

-4t Bulk Update

565 Bulk Update

n
u
[n]
r]
u
(%]
[=]
L]
-8
(]
=]

System Setup

Note: If one operation on an object or the auto approval of the object fails, changes made by other operations are
rolled back, and the object is left as it was prior to the bulk update.

When the process has completed, the following options are available beneath the Bulk Update Actions flipper at
the bottom of the Background Process tab.
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Background Process JReTCICRG

Context: Contextd

Workspace: Main

Commit Mode: Pre-Flight Check (rollback)
Auto Approve: Mo

Collection: BGP_111871 tmp input
Configuration: temparary configuration

Applying operations to dataset (Tue Aug 23 16:43:13 EDT 2016)

(rollpack) (Tue Aug 23 16:43:13 EDT 2016)
Summary (Tue Aug 23 16:48:13 EDT 2016)
0 objects QK. 1 objects failed.
0 info messages. 0 warning messages. 1 Error messages.
Operations Summary (Tue Aug 23 16:48:13 EDT 2018)
Cperation 1: [Add Reference]

Errars: 1

1. Unable to create reference

End of Summary

¥ 4 | 1-200f20 b 213

st Quung
Relaunch Wizard Bulk Update QK Ohjects Save Failed Objects

Created Tue Aug 23 16:48:11 EDT 2016 /
Started Tue Aug 23 16:48:13 EDT 2016

Finished Tue Aug 23 16:48: 13 EOT 2016

Processing Time Om0s

Time in Queue Om2s

# of warnings ]

#oferrors 1

7 Execution Report

Bulk update background process started (Tue Aug 23 16:48.13 EDT 2016)

Read bulk update operation configuration successfully (Tue Aug 23 16:48:13 EDT 20186)
Created tempaorary collection: BGE 111871 tmp fail (Tue Aug 23 16:48:13 EDT 2016)

11 [(111204), operation 1] Error: Unable to create reference of type WebsiteLink from Product (111204) to Classification Exterior

Save... Truncate

5.

Impact Report

1. Click Save to keep a copy of the execution report. This can be saved locally on a user's system.

2. Click Truncate if not all lines in the execution report are needed. Upon selecting Truncate, a dialog will appear
allowing users to select which lines to dispose of, and how many lines to retain.
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33 Truncate execution report

Mumber of lines to retain | 20

Execution report entry types to delete

[ Erraor
Info
[ ] Warning

QK Cancel

. Click Relaunch Wizard to open the Bulk Update wizard again. The wizard opens with the same objects
selected and with the same operations specified as in the process that was just completed.

. Click Bulk Update OK Objects if a pre-flight process was run and a user wants to run a bulk update on the
objects that were processed without errors in the pre-flight process.

. Click Save Failed Objects to save the objects for which the bulk update failed. These objects can be saved as
a new collection. Note that this option will only be available if there were failed objects.

. Click Impact Report to view a report of the errors that occurred during the bulk update process. This option will
only be available if objects failed during the bulk update.
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Scheduling Bulk Updates for Collections

Scheduling a bulk update with collections can be useful for a group of objects that need to be updated on a regular

basis. Additionally, should a user want to schedule a group of objects for a bulk update instead of performing it
manually, they can only do so using collections. An example of this might be if a user knows that they need all

current accessory references removed at a certain time on a group of objects before they are to be implemented
into a workflow.

There are a few prerequisites that must take place before a collection is scheduled to run a bulk update.

1. A collection must first be created. More on creating a collection can be found in the Creating Collections topic

in the Getting Started / User Guide documentation.

2. A bulk update configuration must be created. See Running Bulk Updates in the Bulk Updates

documentation for more on how to configure a bulk update.

The steps below explain how to schedule a bulk update using collections.

Scheduling Bulk Updates

Ifa

user wishes to perform a bulk update on a collection at regular intervals, they can create a schedule that

applies to that particular collection. The bulk update is then automatically run at the scheduled time.

To begin, open the Schedule Bulk Update wizard by going to File > Bulk Updates > Schedule Bulk Updates.

File

Edit View Mavigate Format Maintain Window Help

Translate »

Import b

Export ]

Reports

Bulk Update » %] Run Bulk Update
Schedule Category Profiling Schedule Bulk Update

Close Window
Exit STEPworkbench

Step 1 - Setup

On

1.

the first screen, specify the collection and the configuration that is needed.

Click the ellipsis button (...) to locate and select the relevant collection. If the collection selected is created using
the search criteria, and the Refresh before each run (Search Collections only) checkbox is selected, it will
refresh the collection based on the current data in the STEP system using search criteria, and execute the bulk
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update operations. If the collection was created by going to File > Bulk Update > Run Bulk Update, then this
option will not be valid.

2. Click the ellipsis button (...) to locate and select the relevant configuration.

3. Check Auto approve changes if you want to place the updated objects in the approved workspace
immediately after the update.

4. Click Next.

33 Schedule Bulk Update

Steps Setup
1. Setup
SRS Collection
3. Sthedule Process Assets made with Search (111650)

4. Mame Process
[ ] Refresh before each run (Search Collections only)

Configuration
Asset Search Configuration (111652) m

[] Auto Approve Changes

Back Mext Finish Cancel

Step 2 - Preview
This screen shows an examples of the results of the update. Click Next to continue.
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32 Schedule Bulk Update

Steps Preview
L. Setup Object > » [Set single value [Captioni] [
2. Preview N ald
- HYD543 - :
3. 5chedule Process » Mew Pictures by Stibo Inc.
4, Mame Process ’ old
—FRP4100
» Mew Pictures by Stibo Inc.
LlEIas'.SES old
» Mew Pictures by Stibo Inc.
LE':.fiam Case old
> ! Mew Pictures by Stibo Inc.
LE':.fiam open old
> SiiE Mew Pictures by Stibo Inc.
» Old
—Ewi ck
> [Vian. ba Mew Pictures by Stibo Inc.
» Old
> Ve i3 Mew Pictures by Stibo Inc. W
Back Finish Cancel

Step 3 - Schedule Process

In Step 3, create the time schedule. Select either Now, Later, Weekly or Monthly. The available options depend
on user selection. Select the options needed, and then click Next.

$2 Schedule Bulk Update

Steps Schedule Process
1. Setup Start
2, Previ
sy ) Mow Start at (hh:mm): 11:04
3. Schedule Process
4. Name Process i Later Start on (yyyy-mm-dd): |2016-08-19
® Weekly‘ End on (yyyy-mm-dd): |-
() Monthly Every: Mon []Sat
() Later and repeat []Tue []5un
[] wed
[]Thu
[] Fri
Start every mon at 11:04, starting 2016-08-19
Back Mext Finish Cancel
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Step 4 - Name Process
In the final step, enter a name for the Schedule Process and for the Process. Click Finish to complete the

wizard.

$2 Schedule Bulk Update

Steps Mame Process

1. Setup

2. Preview

3. Schedule Process
4. Hlame Process

Schedule Process MName:  |Scheduled Bulk Update

Process Mame: Bulk: Update

Cancel

Back Mext

Upon hitting Finish, it will give the user an option of going to the background process. If selected it will take the
user to the background process tab and display the background process.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 59



SliboSystems

€ Scheduled Bulk Update (every mon at 11:04, starting 2016-08-19) - Background Process

Background Process

§Popertes

Property * Value »
Started by USERL

Id BGP_111657

Description Scheduled Bulk Update {every mon at 11:04, starting 2016-08-19)

Execution Server

docrel

Gtatus waiting - 1 of 1in SCHEDLULE
Created Fri Aug 19 11:13:35 EDT 2016
Started Fri Aug 19 11:13:36 EOT 2016
Finished Fri Aug 19 11:13:36 EOT 2016
Processing Time Om0Os

Time in Queue Omls

# of warnings ]

# of errors i

Start After Mon Aug 22 11:04:00 EDT 2015

§ BxeafonReport

1 Collection: Assets made with Search
2 Configuration: Caption 1 Configuration

H 4 | 1202 Ik M Truncate
If the bulk update is scheduled, then it will show under 'Queued process'.

--% STEP Workflow Profiling
El% Scheduled Processes
: E}% Queued Processes

¢+ Bcheduled Bulk Update (every mon at 11:04, starting 2016-08-15) |

-5 Active Processes

% Ended Proceszes
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